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Chapter 1

Welcome
This program calculates the taxable profits of partnership and sole trade businesses from their
accounts information.

You can enter accounts information manually or you can import data from Sage Accounts
Production, Sage Accounts Production Advanced or a number of other popular accounts software
packages.

Business Tax does not directly fill out any tax returns. Data entered is processed for use on tax
returns, and is then transferred to the applicable program for printing the tax return. If the client is
a partnership the information is transferred to Partnership Tax to complete the SA800 tax return. If
the client is a sole trader, you can transfer income tax details directly to Personal Tax for the SA100.

Finding your way around Business Tax
The Sage Business Tax window is made up of the following areas:

Main Menu and Toolbar: From here you can access all the functions in Business Tax. For example,
this is where you select a different client to work on, or set up new accounting periods for a client. All
the functions can be found in the main menu, but some frequently used functions are also available
on the toolbar for easy access.
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Data Entry window: This is where you view and enter the accounts or tax data for the current client.
This window displays the page you've selected from the Navigator.

Navigator: You may be familiar with the 'tree' structure from other Windows programs. Each folder
in the tree represents an area relevant to the business. You will be using the Navigator extensively
to enter your client's information. This pane displays one of two navigation trees, depending on
whether you are looking at details concerning the accounting period of the business, or its tax
assessment year.
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Chapter 2

Creating clients
There are three ways to create a client that can be used in Business Tax:

l Creating clients in Business Tax will set up the client with the details needed to start entering
information for tax return processing.

If you use Sage Practice Solution and have client integration enabled, clients created in any
Sage Taxation program will automatically be available in Sage Practice Solution. For more
information see Connecting with Sage Practice Solution on page 3.

l Using Control Centre, you can set up clients for any program in Sage Taxation.

l Creating clients in Sage Practice Solution gives you the benefit that your details will be
available to all of the subscribed service programs for the client. If you use Sage Time and
Fees, this will also allow you to create jobs and record time against your clients.

Connecting with Sage Practice Solution
Sage Practice Solution allows you tomanage your clients’ details, link to other Sage products for
practice, record time against work carried out for them and create invoices based on that time.

The software comprises two elements:

n Practice Hub

n Time recording and invoicing

Your licence agreement with Sage will determine which elements are available.

Sage Practice Hub is the central store for your client data. You can use Sage Practice Hub to connect
your Sage Programs, for tasks, communications, reporting, letter writing etc.

We refer to Sage Practice Hubwith Time recording and invoicing as Sage Practice Solution.

More information
For more information about connecting your Sage programs with Sage Practice Solution, start Sage
Practice Solution (v1.5 or above) and from the Helpmenu choose Contents. When the Help system
appears, use the table of contents to find the book Connecting your Sage Programs.

Create a client
Note: If you use Sage Practice Solution and have client integration enabled, clients created in Sage
Taxation will automatically be available in Sage Practice Solution.
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1. From the File menu, choose New. The New Client Wizard appears. Click Next.

2. Select Partnership or Business (Sole Trade) as the type of client and press the Next button.

3. You will then be askedwhich Sage Taxation systems you wish to set the client up for.

If the client is a sole trade, the only system they can be set up for is Business Tax, which is
selected by default, click Next to continue.

If the client is a partnership, they can either be set up for both Partnership Tax and Business
Tax or just Partnership Tax (but not just Business Tax, this is because all Business Tax users
get Partnership Tax inclusive).

4. Ensure the client will be set up for both systems, then click Next. The Add New Client Wizard
will then display a summary of the choices you have made so far. When you click Next, you
will go to a secondwizard, either the New PartnershipWizard or the New Sole Trade Wizard,
depending on the client you are creating. Simply follow the directions on each page of the
wizard to create a new client.
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Accounting Periods and Assessment Years
With Business Tax you can enter information for Accounting Periods and Assessment Years.

Business Tax will open a client in the Accounting Period view. You can tell what view you are in by
the heading of the Navigator.

Working with Accounting Periods 
Make sure you are in the Accounting Periods view by checking the heading at the top of the
Navigator. If not, switch to it by choosing Accounting Periods from the View menu.

The Accounting Period view is where you enter all the information regarding that accounting period.
This is basically the business accounts for that period, any special conditions that apply to that
particular period etc. This is the bulk of the data that you will have to enter for a particular client.

Adding Accounting Periods
There are two ways you add accounting periods for a client:

n The client's first accounting period

As you create a client, the first accounting period will be created automatically when you
specify the start and end date. An accounting period can be as long as 24 months.

Note: Make sure that the accounting period you enter is the earliest you will need for your
client's accounts because Business Tax cannot backdate the client's accounts once this first
period has been created.

For subsequent years, you will be able to create a new accounting period by rolling forward an
existing one.

n Rolling forward to a new accounting period
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With established clients who have existing accounting periods already set up, you create new
accounting periods from within Business Tax by rolling forward the accounts. You can do this
by choosing New Accounting Period from the Tools menu.

Rolling forward will add a year long accounting period starting the day after the end of the
most recent accounting period for that client.

If you need to change this, for example if your client is changing their accounting date and
the period will not be 12 months long , you will have to adjust the end date. To do this, open
the Business Details form, and amend the Period end date on the Period Details tab.

Working with Assessment Years 
You do not need to create assessment years. An assessment year is automatically created for every
year that is covered by the accounting periods created for the client. If you delete accounting
periods, any assessment years no longer covered by the accounting periods will also be deleted.

The Assessment Year view is where you enter any information specific to a particular tax year. This
is where you enter overlap details, cash basis UITF 40 adjustments, and income averaging.

Most of the information for the Assessment Year will be generated automatically andwill not need
to be edited. For example, the data for that year's overlap days and profits will be calculated from the
accounting period dates and the accounts data you have entered. Likewise, the information (in
partnerships) concerning when individual partners joined and left the business is entered into the
Main Details section.

Overlap days and profits
If you are using Business Tax for the first time with an existing client, they may have accrued
overlap profits on commencement (andwith prior changes of accounting date).

In this case you should enter the overlap days brought forward for the first assessment year you
cover for your client.

To enter overlap days and profits

1. Change to the Assessment Years view by clicking Years on the toolbar.

2. For Partnerships, click Partner Details in the Navigator then click the + next to the partner
you want to enter overlap profits for. This opens the folder for that partner.

3. Select Overlap Profits in the Navigator. The Overlap Profits form appears.
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4. Enter the overlap profits details for each assessment year in the grid. You can change the cell
to edit by clicking it or by using the cursor keys.

5. Click the Overlap Days tab and enter any overlap days for the partner.

6. Click Save on the toolbar when you have finished.

You may also need to enter details of any cash basis adjustments, income averaging or adjustment
income that may apply to the client in this tax year and deductions made by contractors on account
of tax for the tax year.

Whilst all other data should be generated by the rest of the program,much of it can be edited in the
Assessment Years view. Any amended data will then carry over to where the information was
generated from in the first place.
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Enter your client's accounts data
Once you have set up an accounting period for your client, you can begin to enter the client's
income and expenses for the period.

Data is entered by selecting an item from the Navigator then filling in the form that appears in the
right-hand pane.

Data entry forms
Data entry forms are where you enter information that is used in calculating the taxable profit for a
business.

Most data entry forms are organised into a number of tab pages.

To see what's on a tab page, click its tab. For example, clicking the Expenditure tab will bring the
Expenditure page to the front.
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At the top of most data entry forms you'll see a check box called Completed. When you're satisfied
that you've entered sufficient information in a data entry form, tick the Completed box. Business
Tax will add a tick to that item in the navigator tree to help you track progress.

Completing Business Tax forms
The majority of the forms in Business Tax use the samemethods of entering data and similar boxes,
for ease of use. Once you know how to fill in one of the forms, the rest should be simple.

If you do run into problems, you can find details on each form within the Reference section of the
online Help.

Adjusted Profit Computation forms
Individual income adjustments can be made by using the adjusted profit computation (APC) forms.
You must make sure you are using the right form for the adjustment you are entering.

To access APC forms for a sole trader

1. Switch to the Accounting Periods view.

2. Select Income and Expenses in the Navigator. The Income and Expenses form appears.

3. Click the button to the right of the Non Trading Income box.

To access APC forms for a partnership

1. Switch to the Accounting Periods view.

2. Expand the partners' details in the Navigator by clicking the plus symbol.

3. Select Income and Expenses in the Navigator. The Income and Expenses form appears.

4. Click the button to the right of the Non Trading Income box.

However, if the business is a Partnership, then you can either enter the adjustment under the
business or associate it with an individual partner. If you need to associate an adjustment with an
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individual partner, you must enter the adjustment on a different form. Follow these instructions to
find the correct form:

To find the APC form to enter Sole Trader's income adjustments or Partnership income adjustments
associated with the business:

1. Open the Standard Accounts Information folder on the Accounting Period view of the
Navigator.

2. Select the Income and Expenses form andmake sure you are viewing the Income tab.

3. There are three categories of income you can enter:

Sales (Turnover),

Other Income and

Goods Taken for Own Use.

4. Click the button next to the type of adjustment you wish to enter. This will open the form
you need to use.

Note: You can change between these income types within the APC form, so you can enter
different types of income adjustment without having to close the form.

5. If you are entering business income adjustments for a partnership, the form will have two
tabs, business adjustments and partner adjustments. Ensure you are viewing the business
adjustments tab (the data on partner adjustments tab is read only and there purely for
information purposes, if you need to enter partner adjustments, you need to use the form in
that partner's folder, see below).

To find the APC form to enter Partnership income adjustments associated with individual partners:

1. On the Navigator Tree open the Partner Details folder.

2. You will see that underneath the Profit Sharing Ratios form there is a folder for each partner
in the business (Business Tax derives the information about which partners are in the
company from the data you have entered concerning partners on the Main Details forms for
this business). Open the folder for the partner who you want to associate this asset with.

3. Select the Income and Expenses form inside that folder andmake sure you are viewing the
Income tab of the form.

Capital Allowances
You can enter details of a client's Capital Allowances using Business Tax.

Capital Allowances can be recorded for the business as a whole or the individual partners. In the
Accounting Periods view, expand the Capital Allowances folder to enter for the business, or you can
find Capital Allowances in each partner's folder.

The Capital Allowances are divided into the following sections:

n Motor cars costing over £12,000

n Private use assets

n Short life assets
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n Industrial buildings

n Agricultural buildings

Additionally there is a pool for general assets.

You can enter data for these categories in one of two ways:

n Enter the total allowances and balancing charges for each category on the SA800 and SA103
forms.

To do this, enter your data in the relevant boxes on the Capital Allowances Summary form
(accessed by clicking on the Capital Allowances folder on the Navigator), entering allowances
and charges on their respective tabs.

n Alternatively, Business Tax will calculate these figures for you from transactions that you
enter in the individual category forms.

As far as possible, the way you enter the transactions in different categories has been kept standard.
The only major difference to the way you enter transaction data occurs if you enter data for assets
which are recorded individually as opposed to those which can be pooled for the purpose of capital
allowances.
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Import accounts data
You can import data from a number of accounts production packages into the appropriate areas on
the Business Tax forms. This eliminates the need to retype data.

What data is imported?
You can import nominal balances (income and expenditure accounts only or the full trial balance) or
pre-summarised figures ready for the tax return. When nominal balances are imported, the
allocation of balances across the tax return headings is automatic. Templates providedwith Sage
Taxation manage the allocation of balances during the import.

What packages can I import from?
Data can be imported from almost any accounts or spreadsheet package.

Sage Accounts Production Advanced and Sage Accounts Production export the figures required by
the tax return in a convenient format.

Import Sage APA accounts data
This procedure requires you to do some tasks in Sage APA, then some tasks in Business Tax.

To export the accounts data from Sage APA:

1. Start Sage APA and log in as normal.

2. From the Tools menu, choose Sage Links then Export to Sage Taxation. The Export to Sage
Taxation window appears.

3. If the client you want to export is not shown, change it.

To change client, click on the client's name in the Current Client (sometimes just Client) box.
The Client Selection window appears. Click on the name of the client you want to open, and
click OK.

Note: If you can't see your client in the list, from the Search Criteria drop-down list choose
All Clients.

4. Choose the year's data to export from the Year drop-down list.
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5. Although you can change the path for the export file, it's recommended to leave it with the
default. The export file will be saved in the correct location for your Sage Taxation programs
to find. The filename contains your client reference and year end date to help you.

Note: If the export path begins, C:\hc\ASCII, you need to tell Sage APA where you've
installed Sage Taxation.

a. From the Settings menu choose System Setup. The System Setupwindow appears.

b. Click the Client Integration tab.

c. In the Transmit Directory box, replace the current entry with
C:\SageData\UKTax\Master\Import\AP, where 'C' is the drive letter of your Taxation
installation.

d. Click OK to save the changes.

6. If you want any of the Sage Taxation programs to open as soon as the export file has been
created, choose the appropriate program.

7. Click OK to create the Export file.

8. If your client has cost centres set up you may want to export figures for a particular cost
centre. A window appears asking for the cost centre number to export data from. Enter the
number of the cost centre or leave the box empty if you want all the data exported then click
OK.

9. One of the following things will then happen: 

If you chose to have confirmation only, a confirmation box appears.

If you chose to launch Sage Personal Tax go to point 10.

If you chose to launch Sage Business Tax go to point 11.

If you chose to launch Sage Partnership Tax go to point 12.

10. If you chose to launch Sage Personal Tax:

This assumes you have already set up the client in Sage Personal Tax and set up the self-
employment you want the accounts data to be brought into. If you haven't done this please
refer to the Sage Personal Tax Help.

i. Log in to Sage Personal Tax. The Client List window appears.

ii. Select the client to import the accounts data into.

iii. Click Select. Your client opens.

iv. If the correct year isn't displayed, use the year drop-down list at the top of the
navigator to choose the correct year.
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v. Using the navigator, open the Accounts Information page of the self-employment that
the accounts data is to be usedwith.

vi. Click Accounts Import. You'll be warned that the import will first delete all data for the
current accounting period. Click Yes to delete any data for the current accounting
period. The Accounts Link window appears. 

vii. Choose Sage Accounts Production Advanced (Standard) from the Template drop-down
list.

viii. Click the magnifying glass icon to the right of the Import File box. An open file window
appears.

ix. Use the window to find the file you exported from Sage APA and select it in the
window.

x. Click Open. The filename and path will be shown in the Import file box.

xi. Click Import to import the data. You will see the imported data in the Accounts
Information section of the self employment.

For further information about importing data into Sage Personal Tax, refer to the topic 'What
is the Accounts Link?' in the Sage Personal Tax help.

11. If you chose to launch Sage Business Tax:

This assumes you have already set up the client in Sage Business Tax.
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i. Log in to Sage Business Tax. The Client List window appears.

ii. Select the client to import the accounts data into.

iii. Click Select. Your client opens.

iv. Choose the correct Accounting Period to import the data to.

v. Open the Business and Investment Income section of the tax return.

vi. From the Tools menu, choose Import Accounts Data. The Import Accounts Data
window appears.

Note: The Accounts Import will always import accounts data for the currently selected
accounting period (even if the accounting period you exported was a different one).
Also note that only standard accounts data is transferred, capital allowances and
overlap profits are not.

vii. Choose Sage Accounts Production Advanced (Standard) from the Template drop-down
list.
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viii. Click the magnifying glass icon to the right of the Import File box. An open file window
appears.

ix. Use the window to find the file you exported from Sage APA and select it in the
window.

x. Click Open. The filename and path will be shown in the Import File box.

xi. Click Import to import the data. You will see the imported data on page 4 of the
Partnership Tax Return.

12. If you chose to launch Sage Partnership Tax:

This assumes you have already set up the client in Sage Partnership Tax. If you haven't done
this, please refer to the Sage Partnership Tax help.

i. Log in to Sage Partnership Tax. The Client List window appears.

ii. Select the client to import the accounts data into.

iii. Click Select. Your client opens.

iv. Choose the correct year to import the data to.

v. From the Returns menu, choose Import Accounts Data. The Import Accounts Data
window appears. .
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Note: The Accounts Import will always import accounts data for the currently selected
accounting period (even if the accounting period you exported was a different one).
Also note that only standard accounts data is transferred: capital allowances and
overlap profits are not.

vi. Choose Sage Accounts Production Advanced (Standard) from the Template drop-down
list.

vii. Click the magnifying glass icon to the right of the Import File box. An open file window
appears.

viii. Use the window to find the file you exported from Sage APA and select it in the
window.

ix. Click Open. The filename and path will be shown in the Import File box.

x. Click Import to import the data. You will see the imported data in the Standard
Accounts Information section of the business.
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Producing tax returns
Business Tax exports clients' data to other programs within Sage Taxation to generate tax returns:

n Personal Tax will handle your sole traders' details.

n Partnership Tax will produce the SA800 return for a partnership, before sending individual
partner's details to Personal Tax for their tax returns.

Sending sole trader's details to Personal Tax
Business Tax can send sole trade clients' data to Personal Tax to put on their SA100 tax return
forms. You must transfer data concerning partners to Personal Tax via Partnership Tax. For more
information see Sending partnership details to Partnership Tax on page 18.

If the owner of a sole trade isn't currently set up for Personal Tax, they will automatically be set up in
the transfer. However their Main Details are likely to be quite limited if they were only set up as the
owner of a sole trade business. These details may need updating either within Personal Tax or
through the Trader's Details button in the business's Main Details form.

To start the export, click SA100 on the Toolbar. This option will be unavailable when you are viewing
a partnership client.

Business Tax will calculate which tax year(s) are affected by the period of account from which
posting is taking place, andwill post to those years only. To post to other tax years, you need to
select the period of account which forms the basis period for that year, and post from that period.

However, information messages will still appear; firstly where it is necessary for a decision to be
made as to posting and secondly, to confirm what posting has taken place. If, for any reason,
posting did not complete then amessage will appear to confirm this.

Once the transfer is completed, the client's business will be set up as a self-employment in Personal
Tax in the Earned Income folder on the Annual Data Navigator. You will be able to open Personal Tax
from the confirmation message if you want.

Sending partnership details to Partnership Tax

Business Tax does not directly fill out any tax returns. Data entered is processed for use on tax
returns, and is then transferred to the applicable program for printing the tax return.

n If the client is a partnership the information is transferred to Partnership Tax to complete the
SA800 tax return.
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n If the client is a sole trader, you can transfer income tax details directly to Personal Tax for
the SA100.

To transfer data to Partnership Tax:

n From the Tools menu, choose Post to Partnership Tax Return.

or

n Click the SA800 button on the toolbar.

Either of these methods will open Partnership Tax with the personal and financial details transferred
to the SA800.
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Other features
Business Tax has a number of other features available. Below is a brief description of just a few.

Partnerships and tax avoidance schemes
The disclosure rules for tax avoidance schemes became effective from 1 August 2004.When
working with partnership clients, a tab page is available on the Business Details form.

To enter details of Tax Avoidance Schemes, select Business Details on the navigator tree, then click
the Tax Avoidance Schemes tab on the Business Details form in the right-hand pane.

Change of accounting date
You can use the Business Details form to indicate that a business has changed its accounting date.
Select Business Details from the navigator tree and enter a new date in the Period end date box. As
you do this, the Permanent change of accounting date check box becomes enabled and selected.

Income averaging
For business types where income averaging is permitted, i.e. Farming / Market Gardening or
Creative Artists, you can apply income averaging or perform ‘what if?’ calculation scenarios to help
decide the best course of action for your client.

Treat 31 March - 4 April as 5 April
If you wish to take advantage of the HMRC concession to accept accounts drawn up to a date falling
between 31 March and 4 April inclusive as the equivalent of accounts to 5 April then Business Tax
can accommodate this. In the Accounting Periods view, select Business Details in the Navigator,
then tick the check box Treat 31st March - 4th April as 5th April. The computations will then be
adjusted to take into account the following effect of this claim:

1. The profits of the accounts to any of the above dates will be taxed as though they were for
the year to the following 5 April.

2. For businesses which commence in the period 1 April to 5 April inclusive the assessment for
year 1 will be nil.

3. There will be no overlap profits and therefore no overlap relief for any later year.

The check box can also be used in cases where there is a change of accounting date to any of the
above dates, with the effect that the new date will be treated as though it were 5 April. As a result,
all previous overlap profits will be deductible in the tax year of change.
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Cash basis adjustment
You can apply a cash basis adjustment to your business clients using Business Tax. Only some
businesses can qualify for a cash basis adjustment.

In Business Tax, your client needs to be specified as a business type of Barrister / Advocate. You can
change the business type with the Business Details form.With the business type set to Barrister /
Advocate, the Cash Basis Adjustment option can be ticked on the Edit menu.

When the Cash Basis Adjustment menu item is ticked, a Cash Basis Adjustment tab will be visible on
the General form in the Assessment Year View.

Deleting accounting periods
You can only delete the most recent accounting periods for a client. In the same way you cannot
backdate accounting periods, you cannot delete earlier ones whilst leavingmore recent ones intact.
You cannot delete the first accounting period for a business.

To delete the latest accounting periods, select the most recent accounting period you want to keep,
then choose Delete Subsequent Accounting Periods from the Tools menu. This will then delete all
the accounting periods that follow.

Posting years details grid
Business Tax will determine which posting years are relevant based on the accounting periods
entered for the client. To review or change these years, choose View Posting Years from the Tools
menu.

Global setting for posting
To keep Personal Tax and Partnership Tax synchronised with data from Business Tax there is a
setting to automatically send data when the client is closed in Business Tax.

We’d recommend turning this setting off to prevent half-complete details being sent to Personal
Tax. You can turn this off for an individual client or for all clients.

If you have a client open, from the Tools menu clear the tick next to Post on exit for this client.

If you have no clients open, from the Tools menu clear the tick next to Post on exit for all clients.

Generating a report
Although the printing of tax returns is handled by Personal Tax and Partnership Tax, Business Tax
can produce a plain paper report showing the computations it has performed on your data.

Business Tax can produce reports showing accounts information as well as reports showing
computations.

When you have entered all the client's data for an accounting period, the following steps will produce
the report:
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1. From the Reports menu, choose Computations. The Report Options window appears.

2. Use this window to tailor your report.

3. Optional: You can preview your report before printing if you wish by clicking Preview.

4. Click Print to print the report.
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